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Lab 6: Lunar Cartography 
(Due: 2017 May 02) 

Mosaic Imaging 

Field of View 
The field of view of a telescope/CCD camera combination depends on the focal length, f, 
of the telescope and the overall area of the CCD chip.  The focal length is set by the 
optics of the telescope, in this case by the curvature of the mirror.  Think of the size of 
the CCD chip as seen from the mirror, as shown in Figure 1.  A distance d on the chip 
subtends an angle θ, as seen from the mirror, given by  

tan θ  ≈ θ  = d/f , 
where θ is in radians.  This angle is the same as the angle in the sky from which the rays 
(blue in the figure) must come to focus at d.  Since there are 206265 arcseconds in a 
radian, we can determine the plate scale, s, in arcsec/mm, by setting d to 1 mm, i.e. 
s(“/mm) = θ |d=1 = 206265”/fmm, where fmm is the focal length in mm. 

 
You can see, then, that a long focal length corresponds to higher resolution (smaller s).  
You measured the focal length of the telescope in the first lab, and the pixel size of the 
CCD was given in the table for the second lab.  Use these values to calculate the 
angular size of a pixel (arcsec/pixel), and compare with the value you got in Lab 1.  
Use the number of pixels for the camera, as listed in the table from Lab 2, to 
determine the field of view of the camera, in arcminutes.  Do this calculation in 
your lab book, and include the results in your report. 

Angular Size of the Moon and Need for Mosaic 
The Moon subtends an angle of about ½ degree as seen from the Earth.  Compare this 
with the field of view of the camera, and estimate how many camera fields will be needed 
in the vertical (declination) and horizontal (hour angle) directions.  You will see that 
more than one camera frame is needed to cover the Moon entirely.  We will take several 
images of the Moon, moving the telescope slightly between images so as to cover the 
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Moon entirely, and then we will combine the images to make a single, full-disk image of 
the Moon. To do this, we will make use of a Visual Basic script that I have written, called 
RasterSequence, which takes a sequence of images, moving the camera between each, to 
cover an n x n frame area, where n is an odd integer. 

About Mosaics 
As shown in Figure 2, below, a mosaic is just a set of partially overlapping images that 
cover a larger area than a single image would.  A successful mosaic requires a significant 
overlap between the fields.  When it comes time to reassemble the images, you can use 
the overlap to adjust the position and orientation for the best match.  MaxIm DL has a 
mosaic feature that helps with this reassembly. 

 

Procedure for Lunar Imaging 
The telescope should already be set to track the Moon, and Cartes du Ciel should be open 
to show you where the telescope is pointing.  To make sure that you are tracking close to 
the center of the Moon, go to a nearby bright star (within 5-10 degrees of the Moon) and 
sync the telescope so that the star is in the center of the camera frame.  Also ensure that 
you have the best possible focus.  As always, make sure that the camera is at its 
temperature set point, and is stable.  Then send the telescope back to track the center of 
the Moon.  Write down in your log book the declination of the Moon that Cartes du 
Ciel gives.  Because the Moon is so bright, the regular color or luminance filters let in 
too much light to keep the Moon from getting over-exposed.  Instead, on the Expose tab, 
select the H-alpha filter and set the duration of the exposure to the shortest possible, 
which is 0.1 s.  (You can set the exposure time shorter, but it is not really shorter—the 
minimum camera duration is 0.1 s.)  Take an exposure and verify that the Moon is in 
focus and well exposed.  When all is okay, set up a sequence by selecting the Sequence 
tab and using the options button to set up your directory and the following sequence: 
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• Type: Light 
• Filter: H-alpha 
• Suffix: H 
• Exposure: 0.1 
• Binning: 1 
• Repeat: 3 

Close the Setup Sequence dialog, type a unique name in the Autosave Filename, and set 
Start to 1.  Do not click Start, however.  We will let the RasterSequence script take care 
of that.  We set Repeat to 3 so that later we can select the best of the three images from 
each position.  Write the unique filename in your log book—this will be the “stem” 
name for all of your images.  Also write down the filter, the exposure time, and 
repeat count in your log book. 
 
Now start the RasterSequence script by choosing Run Script… from the File menu, 
navigate to the directory LX200GPS\Visual Basic Scripts, and click on 
RasterSequence.vbs.  A DOS window will open—just follow the dialog of the script.  
You can specify the same unique name that you used in the Sequence dialog above.  
When it comes to the question about the size of the raster, enter 3 twice (one for each 
dimension), and select 25% for the overlap.  This will ensure that there are no gaps when 
you go to assemble your image.  Once you have answered all of the questions, the script 
will begin to point the telescope and take the images automatically. 
 
After RasterSequence is done and exits, you have one additional, important step to do.  
We need to know which direction is West.  To do this, you will take two more images, 
and it will be good to have a good section of the lunar limb (edge) in the frame, similar to 
frame 4 in Figure 2.  Set the telescope to point to the spot you want, and open the Scope 
dialog in Cartes du Ciel.  Turn off scope tracking and then without delay take two images 
manually from the Expose tab (exposure time 0.1 s, filter H-alpha), with about 20 s 
between them, saving each with a suggestive, but unique name like drift1.fit and 
drift2.fit.  (Write these names in your log book.) What is happening is that, with the 
telescope drive turned off, the Moon’s image will drift due to the Earth’s rotation, and of 
course it will drift to the west, so the direction of drift will determine the direction of west 
quite accurately.  Because your images have an exposure time of only 0.1 s, the images 
will not be smeared too much due to the motion. 
 
When you are done, you will have 3 images taken at each of 9 different pointings, plus 
your two drift images.  If you had used the name Moon for your Autosave Filename, your 
images for the first pointing would be called Moon_1_1-001L.fit, Moon_1_1-002L.fit, 
Moon_1_1-003L.fit, while for the second pointing they will be Moon_1_2-004L.fit, 
Moon_1_2-005L.fit, Moon_1_2-006L.fit, etc.  The first number is the index of the ROW 
of the image, the second number is the index of the COLUMN of the image.  Make a 
note of this naming scheme in your log book, using your own unique file name. 

Calibration 
In addition to the data on the Moon, we also need to take the bias and dark frames that we 
need for calibration.  In addition, flat frames will be important for this project, to correct 
for non-uniform brightness. 
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Image Analysis 
Once you have your data, you will apply the calibration using the calibration wizard, as 
usual.  After your images are calibrated, look at the three images for each pointing to see 
if one is better than the others.  Select the best one for each pointing, or if you cannot see 
any difference then use any of them.  Write down the number of the ones you chose 
in your log book, so you can recreate your work if something goes wrong.  Once 
you have them selected, open the selected images for all 9 pointings in MaxIm DL.  Then 
select New from the File menu and create a blank image large enough to hold your 
assembled mosaic.  With the new, very large image window selected, choose Mosaic 
from the Edit menu.  In the small window that opens, in the drop-down list choose the 
center image (*_2_2-*) and place it in the center of your large window.  You place it by 
clicking and dragging with the mouse.  When you have it where you want, select “Blend” 
to add it to the image.  Now do the same with the image to the right of the center one 
(*_2_1-*), except this time place it so that the overlapping portion is exactly positioned 
to match the center image.  You may need some practice with this.  Once you get it close, 
you can click “Snap” to make it automatically snap into location, but beware that it might 
fail.  After you have it positioned, select “Blend” to add it to the mosaic.  Continue these 
steps with the other images until all 9 are added to form one complete and well-aligned 
image.  Finally, crop the image using Crop from the Edit menu, to clip off the edges and 
create a more-or-less square image.  Save your final mosaic image with an appropriate, 
unique name. 

Photoshop 
Finding the drift angle: 
Next we will use the two drift images to determine the drift angle, which specifies the 
direction of West.  The easiest way to do this is to open Photoshop CS2 and drag the two 
drift images (one at a time) into the Photoshop window.  This will open a plugin called 
FitsLiberator, which you can use to read in fits files.  When you are satisfied with the 
inputs, load the image and repeat for the second drift image.   
 
Now in Photoshop CS2, select the second drift frame and type Ctrl-A (select all) and 
Ctrl-C (copy), then click on the first drift frame and type Ctrl-V (paste).   You will now 
have both frames in the same window, but in different layers.  In the Layers window, 
change Normal to Multiply, so that you can “see through” the top image.  Important: Set 
the zoom to 100% (Actual Pixels).  Now using only the arrow keys, move the bottom 
image until it perfectly overlays the top image, carefully counting the number of arrow 
taps in x and y.  Hint: if you find that it is difficult to count because there are so many 
arrow key presses, note that at 25% zoom each arrow press moves 4 pixels, at 50% zoom, 
2 pixels, etc.  Write these numbers down in your log book, with arrows indicating 
the direction you had to move the image, as in the drawing below: 
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In this case, the shift was upward in y, which is positive, but to the left in x, which is 
negative.  The total shift, in pixels, is sqrt(x2 + y2). The angle of the shift, then, is found 
by the arctangent, i.e. atan(29,-8) = 105.4 degrees.  Once you have the angle calculated, 
use Rotate Canvas from the Image menu, and type in the number (105.4 CW in this 
example) to place the drift direction exactly to the right (positive x direction).  This is 
west in “Earth” coordinates.  It the Moon is a crescent, it may not be vertical!  You will 
rotate your final image later to align it to “Moon” coordinates.  Test your angle by using 
the left/right arrow keys to shift the bottom image.  You should be able to line up the 
rotated edges of the frames again using only the left/right arrow keys, without touching 
the up/down arrows.  Write your angle and your total shift, in pixels, into your log 
book.  A labeled drawing such as the one above is an excellent way to record this 
information. 
 
Determining the lunar image scale: 
We will now determine the scale (arcsec/pixel) of your images. The easiest way to do that 
is to use the drift measurement and use the fact that the Earth rotates once in 24 h.  The 
rate of rotation in terms of angular distance on the sky is related to the cosine of the 
declination of the Moon.  Say the Moon is at +10˚ 20’ declination and you let the Moon 
drift for 20 s.  At the equator, the Moon would drift 15˚/hour, but at this declination the 
Moon will drift (15˚/hour)*thour*cos(dec), where thour is the total drift time, in hours.  If 
your drift time is 10 s, the total drift would be 

15˚/hour*(20s/(3600s/hr))*cos(10.33) = 0.082˚ = 295 arcsec 
You already measured the drift in pixels, so divide by that to determine the image scale 
(arcsec/pixel).  Write this number in your log book, and compare with the number 
you obtained from the first section of this Lab. 
 
Read in your mosaic image: 
The final step is to read your mosaic image into Photoshop CS2 and orient it with Earth-
west to the right.  Drag and drop your mosaic image into Photoshop to open the 
FitsLiberator dialog.  For intensity scaling, we are going to use square-root, which 
usually does a nice job of setting the brightness scale for the Moon.  Also adjust the black 
point and white point to give maximum contrast without clipping.  Check the 8 bits/pixel 
checkbox.  When you are satisfied, load the image and rotate it by the angle you found 
from the previous step.  You may want to further adjust the brightness scale using menu 
item Image/Adjustments/Levels… Once you have your final image, change to 8 
bits/channel RGB by selecting Image/Mode/ and setting the appropriate menu items.  
Now measure the size of the lunar disk, in pixels, using the Info window and write 
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down the size in your log book.  Finally, compare your image with the lunar map (see 
the course syllabus web page, links near the bottom), and flip the image if necessary to 
bring north to more-or-less the top.  As before, any crescent will not be perfectly vertical.  
You will rotate it further in a moment.  Save the image using Save As… from the file 
menu, saving it as a PSD file. Be careful not to save it as FITS, or you may overwrite 
your original mosaic image. 

Lunar Cartography 
The goal of this lab is to overlay onto your image an accurate grid of lines of longitude 
and latitude in lunar (selenographic) coordinates.  The first step is to obtain some 
“physical ephemeris” information about the Moon for the date and time of your 
observations, using a very nice web site called Calsky.  Go to www.calsky.com, select 
Moon and Physical Data, enter the date and local time corresponding to your 
observations in the controls, and click Go.  You will be presented with data like this: 
Moon 
 
Ephemeris for Physical Observations: 
Date    Mag-  Dia- Flatt- Northpol Open- Centrl  Sub-Solar-Point   Phase  visible  
      nitude meter  ening PosAngle Angle Merid.  Lon   Lat PosAngl       from    to 
2006     mag     '            o      o     o      o     o      o         hh.h  hh.h 
Feb 12 -12.7  29.43 1.000   21.6   -4.5   1.0   -1.0   2.4  356.4   1.00 17.3h- 7.5h 

Where the numbers I have indicated in bold are the ones we will be using.  The numbers 
we need are the Diameter, Northpole PosAngle (P-angle), and Open Angle (b-angle),  
Central Meridian value.  The above numbers are for 2006—your numbers will be 
different!  If the Northpole PosAngle is greater than 180 degrees, convert to a negative 
angle, (i.e. and angle of 343.7 degrees would be converted to (−343.7 + 360 = −16.3 
degrees).  Convert the diameter to radius, i.e. 14.71 in the above example. 

Making a grid using IDL 
You can make a grid in IDL using a routine called Stonyhurst, using the commands: 

plot,[-17,17],[-17,17],/nodata,/iso 
stonyhurst,-4.5,21.6,14.71,CM=1.0 

where the first statement simply makes an empty box in which to plot the disk grid, and 
the second statement actually plots the grid (with numbers appropriate to the example 
above).  The first argument to Stonyhurst is the b-angle, the second is the P-angle, the 
third is the radius, and the CM argument is the central meridian angle.  Make the plot 
window nice and big (replot if necessary), then make a screen shot, and paste it into a 
new window in Photoshop CS2.  Crop the image so that only the grid (without the plot 
border) remains in the image. 
 
In Photoshop CS2, use Image/adjustments/invert to convert it to black lines on a white 
background.  Measure the grid diameter, in pixels.  We need to adjust it to the same size 
as our Moon mosaic image.  Write down the number of pixels, and compare it to the 
number of pixels you wrote down for the solar disk.  If your disk diameter was 665 
pixels, say, and the grid diameter is 720 pixels, then we need to resize (shrink) the grid by 
a factor 665/720 = 0.9236, or 92.36%.  Select the grid by using Color range… from the 
select menu, and set the slider to 100 or so.  A “marquis” border will appear around the 
grid.  Now resize by selecting Transform/Scale from the edit menu.  Type in the 92.4 in 
the X size box, and click the link icon to make X and Y scales equal.  Click the check 

http://www.calsky.com/
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mark.  Now type Ctrl-C (copy), and in your solar image window, type Ctrl-V (paste) to 
paste in the grid.  Now you can move the grid around to fit the disk (you should not need 
to resize if you did your scaling correctly above). 
 
The last step is to rotate the image/grid combined image to correct for the P-angle.  Use 
Transform/Rotate from the Image menu and type in the P-angle to orient the grid 
vertically.  Your image is now in “lunar” coordinate orientation.  When you are happy, 
save the disk with the grid overlay by selected “Save for Web…” from the file menu, 
saving it as a GIF file.  After you save your image, also save the PSD file by selecting 
“Save” or “Save As…” from the file menu, since you will need this if you need to do 
further editing. 
 
You will print a copy of this image for your report.  Now, compare your work with an 
actual moon map by going to the link called “Moon map” on the syllabus page (or go to 
http://ralphaeschliman.com/luna/lnslamasm.jpg).  Compare the grid there with the 
overlaid grid on your image, checking to see where grid lines cross recognizable lunar 
features.  In your report do a self-evaluation of how well these two agree, and speculate 
about reasons for any differences seen.  It might be useful to zoom in on similar parts of 
your image and the lunar map, and compare them side by side in image form.  How 
accurate is your result? 

Bulletized Synopsis 

Purpose: Learn about mosaic imaging and overlay a coordinate grid 
on a Moon map 

• Take a raster sequence of images of the Moon, as well as a pair of drift images. 
• Put the images together into a single-image mosaic. 
• Correct the orientation of the mosaic based on the lunar drift images, to orient 

with respect to Earth coordinates. 
• Create a coordinate grid of lines of lunar longitude and latitude, based on lunar 

physical data. 
• Overlay the grid, and orient with respect to Moon coordinates. 
• Compare the resulting lunar map with a published map. 

http://ralphaeschliman.com/luna/lnslamasm.jpg
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